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System requirements
Microsoft Picture It! requires:

Pentium PC 
Windows 95 or 98 or Windows NT 4.0 or later
16 meg of RAM
90 megabytes of hard drive space

NT users using DBCS folder names should have NT Service Pack 2 or above installed.



Out of memory / Disk space messages
When you work in Microsoft Picture It!, large amounts of image data are stored in temporary files 
that use space on your hard drive. Picture It! uses the system's Temporary drive setting to 
determine where these temporary files should be stored. These temporary files are removed when 
Picture It! closes. Picture It! checks and warns when less than 30 megabytes of free disk space is 
available. If you receive "Out of memory/disk space" errors when using Microsoft Windows 95 or 
98, and you have space available on another hard drive, alter your default setting as follows:

1 From the Start menu, click Run, and then type "SYSEDIT". Press ENTER.

2 Select the Autoexec.bat window 

3 Look for a line that indicates TMP= or TEMP=. If there is such a line, check that the drive 
letter and the location it points to has free space, or change the drive letter to indicate a 
drive with free space.

4 If there is not a line with TMP= or TEMP=, the default will be the TEMP folder in your 
Windows directory. If you want to set Microsoft Windows to use another drive for its 
temporary space, add a the following line to the AUTOEXEC.BAT window and then click Save 
on the File menu.

SET TMP= D:\TEMP    (e.g. drive and path of new temporary location)

Note:    All programs that use temporary files will now write to this new location.    

It is also a good idea to periodically check and delete old files in the temporary folder (e.g. \
WINDOWS\TEMP), especially if applications have terminated abnormally. 



Performance
When Microsoft Picture It! applies effects and manipulates images, it usually operates on a 
significant amount of data. Improve performance by adding memory and turning on "Virtual 
Memory." 

To be sure you have virtual memory turned on, do the following:

1 Right click My Computer.

2 Click Properties.

3 Click the Performance tab.

4 Click Virtual Memory.

5 Be sure the Let Windows manage my virtual memory settings option is checked.

Some tasks, such as Illusions and Remove Dust & Blemish will still be slow because of the complexity
of the work they do. 



Turning sound on and off
If you’re having trouble with sound in Microsoft Picture It!,    make sure your sound card is installed 
correctly and your volume is turned up.

Try to play a sound in another Microsoft Windows application to confirm that your sound is working.
If it is, check Options on the View menu in Picture It! to be sure the Play Picture It! sounds box is 
checked.

If that doesn’t work, you may not have audio compression installed for your sound card. To install 
audio compression:

1 In Microsoft Windows, click the Start button, point to Settings, and then click Control Panel.

2 Double-click Add/Remove Programs, and click the Windows Setup tab. 

3 From the Components list, click Multimedia, and then click the Details button. 

4 Click the Audio Compression box, and then click OK. 

5 Click OK again to exit the Control Panel. You may be prompted for your Windows 95 or 98 CD.



Display optimization problems
If you reset your display settings after receiving a “Display Not Optimized” alert message, you 
might see another alert message that reads, "There is a problem with your display settings…", along 
with the Display Properties dialog box. 

Some video configurations may incorrectly report to Microsoft Windows that a higher resolution or 
color depth is available than is actually supported by the video card, the monitor, or both. Consult 
your system documentation or, to select a different Color palette or Desktop area setting, click the
Microsoft Windows Start button, point to Settings, click Control Panel, click the Display icon, then 
click the Settings tab. 



Using Picture It! and Microsoft Plus 95
If you install Picture It! on a system that includes Microsoft Plus 95, you may not be able to change 
desktop themes. You can correct this problem by replacing the Themes.exe file on your local 
machine with the Themes.exe file in the \Shared\Grphflt folder on the Picture It! CD.



Picture Too Large alert message
When you choose the Custom Scan option and the Scan Picture command, the following message 
might appear:

PICTURE IS TOO LARGE.

The picture you are trying to open is too large for Picture It! to work with. Please make sure that 
the width and height of your picture are both smaller than 3968 pixels.

This problem is the combined result of a scanning area that’s too large and a scanner resolution 
setting that’s too high. You can fix this problem by using one or both of the following solutions:

Reduce the scan area in the scanner application.
Reduce the scanner resolution in the scanner application.



Printer out of memory Error
If you send a large file to a laser printer, you may get "an out of memory" alert message. Here are 
the likely sources and solutions of this problem:

Your printer doesn’t have enough memory to print the file. If your printer has room for 
additional memory, install it. To find out how much memory you can add to your printer, check the 
printer manual. 

You need to change the printer driver settings. If you’ve recently upgraded the printer 
memory, check the printer driver settings. The total amount of installed memory should be the 
same as the number that appears on the Device Options tab of the printer’s Properties dialog box. 
Should you need to change the settings, check the printer manual, printer manufacturer, or your 
operating system's online Help file.



OLE support
Slide shows created by Picture It! do not support the OLE Link to file option. Always embed objects
when working with OLE support and Microsoft Picture It! slide shows



Picture It! 99 and Microsoft Camcorder application
Microsoft Picture It! may terminate unexpectedly when used with the Microsoft Camcorder 
application that shipped with Office 97. 



Importing and exporting non-MIX files
File formats Microsoft Picture It! can open

 There are several third-party or custom image files formats that Microsoft Picture It! cannot 
open. Check the manuals of the software that created those files for more information on how to 
convert them to a form that Picture It! can read.

Microsoft Picture It! supports the following image formats:

DXF CDR EPS GIF JPG

PCD DRW PCX PNG TIF

TGA BMP, DIB WPG WMF PIC

FPX MIX v1, v2

For more information about supported features or restrictions of a particular format, see the 
following:

MIX v1, v2

Microsoft Picture It! version one format. Picture It! 99 reads and supports all version 1.0 files.

When saving to this format, Microsoft Picture It! can also write version 1.0 compatible files. When 
doing so, Picture It! will preserve your cutouts, "locking down," or saving, all the effects that are 
unavailable in version 1.0. . These effects include edges, shadows, fills, distortions, and text bends. 

Picture It! will also convert text objects with any effects to graphic objects that cannot be 
changed within version 1.0. You cannot edit the effects or the text, even if the file is re-opened in 
Picture It! 2.0.

DXF

The AutoCAD Format 2-D graphics filter (Dxfimp32.flt) supports all AutoCAD versions through 
Release 12, including AutoCAD for Microsoft Windows.

The filter has the following limitations:
Extrusions that are part of 3-D drawings are not supported.
Control codes and special characters embedded in text shapes that require special 

characters are not supported.
The .dxf files that require separate shape definition files are not supported.
For multiple viewport .dxf files, the file is imported using the current viewport.

CDR

The CorelDRAW graphics filter (Cdrimp32.flt) supports .cdr, .cmt, .cmx, and .pat files from 
CorelDRAW 3.0, 4.0, 5.0, and 6.0, and has the following limitations:

CorelDRAW Preferences--such as page size/orientation, units, grid, and guidelines--are not 
supported.

Lenses and powerclips are not supported.
Pages, layers, and groups are not supported.
OLE objects are not supported.
Rotated bitmaps are not supported.
Object and PostScript texture fills are replaced with solid gray fills.
Gradient fills are split into monocolored stripes.



Vector fills are not supported.
Multi area paragraph text is not supported. 

EPS

The Encapsulated PostScript graphics filter (Epsimp32.flt) supports the Adobe Systems 
Encapsulated PostScript Specification versions 3.0 and earlier. The filter supports .eps images from
tagged image file format (TIFF) and Microsoft Windows Metafile (.wmf) embedded previews. 
Microsoft Picture It! will only import the rasterized thumbnails from these files; EPS files without 
thumbnails will appear blank within Picture It!

GIF

The Graphics Interchange Format filter (Gifimp32.flt) supports file format versions GIF87a 
(including interlacing) and GIF89a (including interlacing and transparency). The GIF filter works 
with the Portable Network Graphics filter (Png32.flt) to import GIF files into Microsoft Picture It!.

The GIF filter has the following limitation: Only the first image of a multi-image (animated) GIF is 
imported.

JPG, JPEG

The JPEG graphics filter (Jpegim32.flt) supports Version 6.0 of the JPEG File Interchange Format 
(JFIF).

The JPEG filter has the following limitations:
The filter does not support JPEG Tagged Interchange Format (JTIF) files.
The filter does not support cyan-magenta-yellow-black (CMYK) JPEG files.

PCD

The Photo CD graphics filter supports Kodak Photo CD Version 3.0.

DRW

The Micrografx Designer/Draw graphics filter (Drwimp32.flt) supports Micrografx Designer 3.x, 
Charisma 2.1, and Draw files. The filter imports the entire first page of the file as it would appear 
in Micrografx Designer because these files don't contain information about the size of the image. 
Once the image is imported, you can crop the bounding box to make it fit the size of the image.

The Micrografx Designer/Draw filter has the following limitations:
Text arrays are not supported.
Some Micrografx Designer 3.x fonts are not supported.
Clip paths and tiled paths aren't supported.
Gradient fills aren't supported.

PCX

The PC Paintbrush graphics filter (Pcximp32.flt) supports all versions of the .pcx file format 
through ZSoft version 3.0, with support for 256-color images. 

PNG

The Portable Network Graphics filter (Png32.flt) supports files conforming to the Portable 
Network Graphics Tenth Specification (Version 1.0)

TIF



The Tagged Image File Format graphics filter (Tiffim32.flt) supports all image types and 
compressions that conform to TIFF Specification Revision 5.0 and 6.0, Part1: Baseline TIFF. These 
types include monochrome, grayscale, palette color, and RGB Full Color images. The filter correctly 
handles a single 8-bit alpha channel stored with an RGB Full Color image. The TIFF filter also 
supports the TIFF Extension for CMYK images.

The TIFF filter has the following limitations:
Only the first image of a .tif file with multiple images (subfiles) is imported.
The filter does not support multiple alpha channels (stored as subfiles) or alpha channels 

that don't have 8 bits per pixel.

TGA

The Targa graphics filter (Tgaimp32.flt) supports Truevision Targa images with up to 32 bits per 
pixel.

BMP    DIB

The Microsoft Windows Bitmap graphics filter (Bmpimp32.flt) supports Microsoft Windows and 
OS/2 bitmaps, Run Length Encoded (RLE) bitmaps, and device-independent bitmaps (DIB).

WPG

The WordPerfect Graphics import filter (Wpgimp32.flt) supports WordPerfect Graphics versions 
1.0, 1.0e, and 2.0, which correspond to WordPerfect version 6.x and earlier. For graphics stored in 
WordPerfect documents, the filter uses the size of the picture frame stored in the document to 
determine the size of the picture to import. For .wpg images created in DrawPerfect, the frame 
size is the size of the screen.

The WordPerfect Graphics import filter has the following limitations:
PostScript information is lost in Encapsulated PostScript images embedded in WordPerfect 

Graphics files.
WordPerfect Graphics files with large, embedded bitmaps may not appear properly on 

computers that use the Mach series video drivers from ATI. If you think you have this problem, try
running Microsoft Windows Setup and changing your video driver to the 8514/a drivers supplied 
with Microsfot Windows.



Associating a file type so Picture It! will be the default application to open 
it
Microsoft Picture It! will set itself as the default application to open an image file if the file type 
doesn’t already have a program associated with it. If you have a file type that Microsoft Picture It! 
can open, and you wish to set Picture It! as the default program to open it, do the following:

1 In My Computer or the Microsoft Windows Explorer, click the View menu, and then point to 
Folder Options.

2 Click the File Types tab.

3 In the Registered file types list, click the file type that you want to change.
The settings for that file type are shown in the File Type Details box.

4 Click Edit.

5 In the Actions box, click Open.

6 Click Edit, click Browse , and then select the Microsoft Picture It! icon. Microsoft Picture It! 
is in the Microsoft Picture It! directory under Program Files. 

Note: There are several third-party or custom image files formats that Picture It! cannot open. 
Check the manuals of the software that created those files for more information on how to convert
them to a form that Picture It! can read.



Associating a file type so another program will be the default application 
to open it
Microsoft Picture It! will set itself as the default application to open an image file if the file type 
doesn’t already have a program associated with it. If you have a file type that Microsoft Picture It! 
has set itself to open, and you wish to set another program to open it instead, do the following:

1 In My Computer or the Microsoft Windows Explorer, click the View menu, and then point to 
Folder Options.

2 Click the File Types tab.

3 In the Registered file types list, click the file type that want to change. The settings for that
file type are shown in the File Type Details box.

4 Click Edit.

5 In the Actions box, click Open.

6 Click Edit, click Browse, and then select the program you want to use to open that type of file. 

NT Users who use the Wang or Kodak Image Viewer to view .tif fax files should re-associate 
the .tif file extension with the Wang or Kodak Image Viewer, because Microsoft Picture It! will only
show the first image (so only the first page) of such a faxed file.



Uninstalling Microsoft Media Manager
If you decide not to take advantage of the cataloging features Microsoft Media Manager offers, 
you can uninstall the program. Uninstalling Microsoft Media Manager frees up disc space and active 
memory.

1 Click the Microsoft Windows Start button, click Settings, and then click Control Panel. 

2 Double-click Add \ Remove Programs.

3 Click the Install/Uninstall tab, then from the Select “Microsoft Media Manager” from the list 
and click Add/Remove.

4 Follow the on-screen instructions carefully.

Be sure to select the Convert folders back option from the Media Manager uninstall, so that 
you will still have access to the files created in folders converted to Media Manager folders.

Note:      If you uninstall Microsoft Media Manager without uninstalling Picture It!, cataloging 
functions within Microsoft Picture It! will no longer work.



Mustek flatbed scanners
At this writing, the drivers for Mustek flatbed scanners, including the 1200 Pro, do not work with 
the Picture It! Smart Task Scan feature. This is due to a driver error. Future updates to the 
scanning software by Mustek may fix the problem. Contact Mustek at http://www.mustek.com for 
software update information.



Turning off Virus Checkers
Some virus checking programs will not allow Picture It! to be properly installed. If you encounter 
problems during installation, it may be necessary to first turn off the virus-checking program. 

To turn off a virus-checking program perform one of the following procedures:
If an icon appears on the right end or bottom of your Microsoft Windows taskbar, right-

click the icon and choose a command to turn it off (command names vary, but may include Close, Exit
and Suspend)

--or--
If no icon appears on your Microsoft Windows taskbar, try holding down the following keys 

at once CTRL+ALT+DELETE. You will see a list of all the programs that are running. Select the 
virus-checking program, and click End Task.



Using version 1 or version 2 content with Picture It! 99
Most content used in previous versions of Microsoft Picture It! can still be used in Picture It! 99. If
you insert a version 1 or version 2 CD you can still open the content.

1 On the Picture It! File menu, click Open.

2 In Click a Folder list, point to the CD-ROM drive that contains the Picture It! CD.

3 Click the plus sign (+)next to the Content folder. 

4 To open a template, click the Projects folder and then choose the project you want. 

5 To open PictureArt, click the Pict_Art folder, and then choose the category and subcategory 
you want.



Getting Microsoft Windows NT version 4.0 Service Pack 3
If you have a version of NT version 4.0 that's older than Service Pack 3, you will need to upgrade in
order to use Microsoft Picture It!

Order the Windows NT 4.0 Service Pack 3 CD 

Customers in the 50 United States and Canada can order the North American version of Service 
Pack 3 for Microsoft Windows NT for US $14.95 (CDN $20.95) plus customer service and handling 
charges of US $5 (CDN $7.50). Customers can order the product by phone or mail. 

Phone (800) 370-8758 
Fax (716) 873-0906 
In the 50 United States, mail to

Microsoft NT Service Pack 3 
PO Box 1095 
Buffalo, NY 14240-1095 
In Canada, mail to 

Microsoft Service Pack 3 PO
Box 643 
Fort Erie, ON L2A 6M1 

Canada 

Request part number 236-00789 for the North American (128-bit) version and Part Number 236-
00791 for the International English (40-bit) version. 

IF YOU ARE ORDERING THE 128-BIT VERSION OF SERVICE PACK 3, PLEASE NOTE: The 
North American version of Service Pack 3 is intended for distribution only in the United States and
Canada. Effective January 1, 1997, export of this Service Pack from the United States is regulated
under "EI controls" of the Export Administration Regulations (EAR, 15 CFR 730-744) of the U.S. 
Commerce Department, Bureau of Export Administration (BXA). EI controls are the current 
equivalent of ITAR munitions export controls that previously applied to this product. EI controls 
require that you obtain a Commerce export license prior to any export, transmission or shipment of 
this product to any country, other than Canada, or to any person, entity, or end user subject to U.S.
export restrictions. For further information, the Commerce export license process and EI controls 
are described on BXA's Web site. Microsoft will distribute the North American version of Service 
Pack 3 to U.S. or Canadian companies or persons for end use in the U.S. or Canada only.



Picture It! Trial version filter problems when installed over Picture It! 
If you installed the Microsoft Picture It! Trial version after installing Picture It! 99, you may 
encounter some FPX filter problems. To fix these problems, please reinstall Picture It! 99.



Microsoft Media Manager Help
Some of the help topics in Media Manager's help file are out of date and inaccurate. 



Manually updating the Microsoft Media Manager index
If you add files to your Media Manager My Pictures folder from Microsoft Windows Explorer, you 
will need to update the index manually in order for the Picture It! search to find the files.

1 In Microsoft Windows, click Start, click Windows Explorer, then right-click your My Pictures 
folder .

2 Point to Index, then click Update. 



Display problems with Number Nine Visual Technology Video Card
There are some highlight drawing problems in Picture It! on the following system: 

Manufacturer: Number Nine Visual Technology
Adapter Type: Imagine(tm) Series 2 (HawkEye, Direct Draw) 
Version: 4.0
Monitor Type: Liyama Vision Master MF-8317



Hewlett-Packard LaserJet 5si and 4si
Some systems may experience problems when printing reprints to HP LaserJet 5si and 4si printers 
on Microsoft Windows 98. This problem may be fixed by downloading and installing the latest 
drivers for these printers from the HP web site at http://www.hp.com.



Minolta Dimage Scan Dual film scanner
Colors scanned using the Minolta Dimage Scan Dual film scanner may come out wrong. This is due to 
a driver error. The following steps may fix the problem:

1 Launch Microsoft Picture It!

2 On the View menu item, click Options.

3 Click the Scanner/Camera Options button.

4 Set Scanner Performance to Normal.



Plustek flatbed scanners
At this writing, the drivers for some Plustek flatbed scanners do not work with the Picture It! 
Smart Task Scan feature. This is due to a driver error. The following steps may fix the problem for
some scanners:

1 Launch Microsoft Picture It!

2 On the View menu item, click Options.

3 Click the Scanner/Camera Options button.

4 Set Scanner Performance to Normal.

I f the above steps do not help, future updates to the scanning software by Plustek may fix the 
problem. Contact Plustek at http://www.plustek.com for software update information.



Visioneer flatbed scanners
At this writing, the drivers for Visioneer flatbed scanners, including the PaperPort 6000, do not 
work with the Picture It! Smart Task Scan feature. This is due to a driver error. Future updates to 
the scanning software by Visioneer may fix the problem. Contact Visioneer at 
http://www.visioneer.com for software update information. 



Year 2000 issues
Microsoft Picture It 99 interprets dates differently, depending on which version OLEAUT32.DLL is
installed in the system folder of your computer.

If the version of OLEAUT32.DLL that's installed in your system folder is 2.20.4049 or later, 
Picture It 99 interprets dates entered with an abbreviated year format, such as mm/dd/yy, as 
follows:

1/1/00 through 12/31/29 are interpreted as 1/1/2000 through 12/31/2029
1/1/30 through 12/31/99 are interpreted as 1/1/1930 through 12/31/1999

If you have Office97 and/or Windows NT 4.0, your system probably has a version of 
OLEAUT32.DLL that follows the previously outlined rules.

If the version of OLEAUT32.DLL that's installed in your system folder is earlier than 2.20.4049, 
Picture It 99 interprets dates entered with an abbreviated year format as follows.

If the current century is the 20th, 1/1/00 through 12/31/99 are interpreted as 1/1/1900 
through 12/31/1999

If the current century is the 21st, 1/1/00 through 12/31/99 are interpreted as 1/1/2000 
through 12/31/2099

To find out which version of OLEAUT 32.DLL you have, perform the following procedure:

1 On the Start menu, click Find and then click Files or Folders. 

2 In the Named text box, enter Oleaut.

3 In the Look in list, click [C:], and check Include subfolders.

4 Click Find Now.

5 In the list of files, highlight Oleaut 32.dll 

6 On the File menu, click Properties 

7 In the dialog box, click the Version tab, and then read the version number.

If the version is earlier than 2.20.4094 you may wish to download the latest version of this file for 
greater flexibility when working with calendar dates in Picture It! You can obtain this file at: 
http://support.microsoft.com/download/support/mslfiles/Msvbvm50.exe



Microsoft Media Manager installed in Microsoft Windows 98
In Microsoft Windows 98 with Microsoft Media Manager Cataloging installed, folders placed inside 
the \My Documents\My Pictures folder cannot be accessed from Microsoft Internet Explorer. 
Microsoft Picture It! and other programs can still access these folders and subfolders.



PhotoDisc
Note: PhotoDisc digital images are an important part of Microsoft PictureIt!    The following background 
and ordering information is provided by PhotoDisc, Inc. as a service to PictureIt! users.

Enhance your PictureIt! projects with professional 
photography!

Have an idea in mind, but don’t have the right photo on hand? Get just what you’re 
looking for with ready-to-use digital images from PhotoDisc®, the leader in digital stock 
photography.

A Creative Edge.
PhotoDisc’s award-winning photos give you a full range of powerful and professional 
choices for your business and personal communications.    For creative, attention-
grabbing cards, calendars, flyers, mailers, presentations, newsletters, personal web 
pages and more, you’ll find thousands of options with high-quality images from 
PhotoDisc.

The enclosed PictureIt!-ready images are just a sampling from the PhotoDisc collection 
of royalty-free photographs available online. 

For lots of choices at an affordable price, PhotoDisc has an easy new online 
photography collection specially designed for PictureIt! and Microsoft Office® users.    
It’s called PowerPics™.    At www.powerpics.com you’ll find thousands of high-quality 
photos ranging from … 

personal choices such as holiday themes, travel, nature, animals, sports and vintage 
shots, to …

common business themes such as success, time, money, communication and 
teamwork, as well as a myriad of photographic backgrounds and icons (such as 
computers, telephones and more) …

that you can use to add impact to your everyday communications.    Searching through 
the collection is free.    And when you find what you’re looking for, you’ll be surprised at 
how affordable professionally taken photos can be to purchase.    

Each PowerPics image is available in your choice of two sizes — to get the best results 
onscreen or on your desktop color printer. Simply choose your images and your file 
size, and register to purchase. You can have the images you need in just minutes — the



JPEG files are carefully compressed for speedy downloading and easy, rewarding use 
with most PC applications.    

And because PowerPics photos are sold only online, they’re ready when you are: 7 
days a week, 24 hours a day. 

We’ve Taken Care of Everything for You.
As the highest-rated provider of digital stock photography, PhotoDisc has the keys to 
making sure the image is right, every time.    Each of the photographs in the PowerPics 
collection is chosen from the portfolios of award-winning photographers, carefully 
scanned with the highest-quality scanning technology, color-corrected and stored in full-
color JPEG format for dazzling impact.    

And once you’ve made a purchase from www.powerpics.com, your PowerPics images 
are always ready for you from your Previous Purchase page online.    

Five FREE Photos for PictureIt! Users! 
We’re so sure you’ll like the idea of fueling your imagination with professional 
photography online, that we’ve reserved five FREE images for you.    They’re waiting for
you right now at www.powerpics.com.    See for yourself how easy it is to download and 
use high-quality digital photos from PowerPics!

And PhotoDisc is adding fresh new images to the PowerPics collection constantly — be 
sure to check out www.powerpics.com frequently to see the latest ways to add polish to 
your creativity.    

For More Information.
For more information about PowerPics images, please use version 3.1 or higher of your 
browser to access www.powerpics.com on the internet.

Licensing.
For licensing information on the PhotoDisc images included with your PictureIt! 
software, please look to the Microsoft End User License Agreement. For complete 
PowerPics licensing information, please visit the PowerPics site. 



Playing Help movies in Picture It!
If the movies in Microsoft Picture It! Help and the Introduction do not play properly, turn on Video
Compression:

1 In Microsoft Windows, click Start, point to Settings, and then click Control Panel.

2 Double-click Add/Remove Programs, and then click the Windows Setup tab.

3 From the Components list, click Multimedia, and then click the Details button.

4 Select the Video Compression checkbox, then click OK.

5 Click OK again to exit the Control Panel. You may be asked to insert your Microsoft Windows 
CD.



Installing Picture It! on systems with Hewlett-Packard OfficeJet devices
If you have Hewlett-Packard OfficeJet devices installed on your system, you may have trouble 
installing Microsoft Picture It! Usually, turning off the OfficeJet software before installing 
Picture It! solves this problem. To turn off the OfficeJet software, right-click the OfficeJet 
Software Icon on the Task bar, then click Close OfficeJet Software.




